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Subject 

This chapter explains how well information can be annotated in a PCR run (plate, rotor or chip). In addition, 

you learn how to create and rename samples & targets and how to copy run layouts. 

 

 

Summary 

Runs can be annotated before or after import in qbasePLUS. If an annotated run (i.e. it contains Cq values, 

sample and target names, and quantities in case of standard samples) is imported, a sample and target list is 

automatically generated which can be accessed in the Project explorer. qbasePLUS also supports runs without 

annotation: sample and target information can be added after importing the run into the program. Note that 

annotated runs can also be edited in qbasePLUS. While imported Cq values cannot be modified, sample and 

target names can always be edited and additional sample and target information can be included. If 

necessary, single or multiple wells can be excluded from the analysis.  
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Detailed information 

qbasePLUS can handle both annotated and not yet or incompletely annotated runs. If an annotated run 

(which contains Cq values, sample and target names, and quantities in case of standards) is imported, a 

sample and target list is automatically generated which can be accessed in the Project explorer. If additional 

annotated runs are imported, the existing sample and target lists are automatically updated with the sample 

and target names that are included in the imported run(s). An annotated run can be easily edited in 

qbasePLUS. Furthermore, qbasePLUS also allows adding sample and target names after importing (not yet 

annotated) run(s). 

 

 

 

Experiment properties 

General information or important notes related to an experiment can be saved. To access the Experiment 

properties window, double click on the Annotations icon  and then on the Experiment properties icon . 

 

The Experiment properties window has two information fields, one holding the experiment name and the other 

containing additional information about the experiment (Figure 1). When changing the experiment name, the 

text will turn blue if it is a valid name (some special characters are not allowed). A red background indicates 

that an invalid experiment name has been entered. By pressing the Enter keyboard button or clicking the Save 

icon  the experiment name will be updated and the text will turn black again. An alternative way to 

change the experiment name is to select the experiment and press the F2 keyboard button or to use the 

Rename option in the right-click context menu. 

 

Experiment descriptions can be entered as free text. This field can hold multiple lines of information. Therefore 

the Enter keyboard button cannot be used to save the information. Use the Save icon  to save changes to 

the experiment description (blue text will turn black). 

 

 

 

  

 Figure 1 - Experiment properties 
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Create new samples 

This part describes how samples can be created individually. Information about how to import a list of sample 

names and accompanying information can be found elsewhere in this chapter. 

 

 

Step 1 -   Add new sample 

There are four ways to create new samples: (1) by making use of the right-click context menu in the project 

explorer (right click on the samples node and select New sample - Figure 2), (2) by starting the new wizard 

by clicking  on the command bar, or (3) by using the menu bar (File > New). A fourth option is available in 

the run window only: select <New sample> from the sample drop down box. 

 

 

Step 2 -   New wizard 

In case of option 2 and 3: choose Sample and subsequently select the experiment to which the sample 

belongs. Click Finish to complete the New wizard. Note that samples can only be added to loaded (open) 

experiments. Experiments that are not loaded are available for selection, but no sample can be added. 

 

  

 Figure 2 – Sample right-click context menu 
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Step 3 -   Sample properties 

You will see that the new sample is added to the existing sample list. A Sample properties window opens 

where you can edit the sample name, the sample type (unknown sample, negative control, positive control, 

or standard), and the custom normalization factor. 

 

Optionally, a sample description can be added. Blue text indicates unsaved entries. Modifications can be 

saved by clicking the disc , or by closing the sample window. In the latter case, a Save resource window 

opens that allows to save the modifications. A red background indicates that illegal characters have been 

used. 

If you have more than 10 numbered samples we recommend using 'sample01' instead of 'sample1' because 

this results in a better alphabetical sorting in charts. 

 

Prior to version 2.0, quantities for standard samples were to be added to wells in the run editor. Currently, the 

quantity value needs to be entered only once as a sample property. This means that the different samples 

from a standard curve or dilution series should be given a different sample name. If, during import, different 

quantities are provided for a single standard sample qbasePLUS will only retain the last value that is imported. 

 

The Custom normalization factor option (available since version 2.0) allows you to indicate a sample specific 

custom normalization factor. This option enables normalization based on a user provided value such as cell 

number count. In this method, a custom normalization factor must be entered for all samples, or be imported 

as a sample property during import of a sample list. 

 

The Sample visibility in charts option allows you to indicate whether a specific sample or sample type has to be 

shown in the bar chart (Figure 3). By default, negative controls and standard curve samples will not be shown. 

This results in more intuitive charts and gives you more control on the content and look of your results. 

 

Preferences can be modified in top menu (Window > Preferences). By default, only unknown samples and 

positive control samples are shown in the bar chart (Figure 4). Sample specific settings overrule the 

preferences. 

 

 

 

 

  

 Figure 3 – Sample properties 

 

  Figure 4 – Sample visibility options 
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Step 4 -    Close Sample information windows 

Several samples can be added in this way, one by one. Each time a sample is added, a Sample information 

window appears in the Main window. Close all tabs to clean up the Main window. Note that the right-click 

context menu contains a feature Close all for closing all windows at once (see ‘User interface’ chapter for 

more information on these functionalities). 

 

Step 5 -  Add custom sample properties (as of version 2.0) 

Custom properties can be entered one by one in the Sample properties window (Figure 5). The Sample 

properties window can be accessed by double clicking the Annotations icon  and then the Sample 

properties icon. Custom properties are used for visualization (sample grouping and rescaling) and statistics.  

To create a custom property, click Add property at the bottom and enter a name for the property. For each 

sample a value should be entered in this new property column.  

 

Alternatively, custom sample properties can be imported during sample list import (see below).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Figure 5 - Sample properties window 

 



 

  
page 6 qbasePLUS run annotation 

e 

Create new targets 

New targets are added in a similar way as described for the creation of new samples. 

 

 

Step 1 -  Add new target 

There are four ways to create new targets: (1) by making use of the right-click context menu in the project 

explorer (right click on the targets node  and select New target), (2) by starting the new wizard by clicking 

 on the command bar, or (3) by using the menu bar (File > New). A fourth option is available in the run 

window only: select <New target> from the target drop down box. 

 

 

 

Step 2 -  New wizard 

In case of option 2 and 3: choose Target and subsequently select the experiment to which the target needs to 

be added (Figure 6). Click Finish to complete the new wizard. Note that targets can only be added to loaded 

(open) experiments. Experiments that are not loaded are available for selection, but no targets can be 

added. 

  

 Figure 6 – New target wizard 
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Step 3 -  Target properties 

You will see that the new target is added to the existing target list. A window opens in which you can edit the 

target name and enter useful information (such as gene ID & symbol, target type and sequence information) 

(Figure 7). Target information can be transferred through copy/paste from e.g. the RTPrimerDB database 

(available on http://www.rtprimerdb.org/). Blue text indicates unsaved entries. Modifications can be saved by 

clicking the disc , or by closing the target window. In the latter case, a save resource window opens that 

allows to save the modifications. 

 

Note that this target window contains two tabs at the bottom. The properties tab contains the above-

mentioned information, while the Bar Chart tab graphically displays the calibrated normalized relative 

quantities (CNRQ values, i.e. the fold changes relative to the reference level as defined in the Target scaling 

options) of the target across all samples. 

 

 

 

Step 4 -  Target type 

Two types of targets are used in qbasePLUS, Targets of interest and Reference targets. Reference targets (also 

referred to as housekeeping genes, a name deprecated by the MIQE guidelines, Bustin et al., 2009) are used 

for normalization. The target type can be defined via the target properties window (see step 3), or by using the 

right-click context menu in the Project explorer window (cursor needs to be on the target that has to be 

defined) and selecting Set Target Type from the drop down list. 

 

Multiple targets can be simultaneously appointed as Reference targets or as Targets of interest by selecting all 

of them using the 'Shift' or the 'Ctrl' (Windows) or ‘Command’ (MacOSX) keyboard buttons. 

 

Note that all targets labeled as Reference targets are used in the multiple reference gene normalization 

procedure (Vandesompele et al., 2002). To exclude one or more Reference targets, change their type into 

Target of interest, which causes the software to treat them as if they were Targets of interest.  

 

  

 Figure 7 – Target properties 

 

 

 

http://www.rtprimerdb.org/
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Import sample lists 

Importing sample properties from additional columns in a sample import file (Figure 8) is a faster alternative to 

the individual creation of new samples. The format of these import files, as well as example files can be found 

at http://www.biogazelle.com/support/qbaseplus/formats. 

 

 

Step 1 -  Start Import samples wizard 

Right-click in the project explorer on Samples  (or a random sample) to start the Import samples wizard.  The 

import button ( ) in the toolbar will also lead to this wizard when selecting Samples. 

 

Step 2 -  Select sample list 

Select the experiment in which the sample list needs to be imported.  By default, the experiment selected in 

the project explorer is indicated as the target experiment. 

Browse for your sample list file and click the Next button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Figure 8 – Sample import file 

 

 

http://www.biogazelle.com/support/qbaseplus/formats
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Step 3 -  Select properties to be copied (as of version 2.0) 

Select the properties to be copied from the sample list. Sample name and type are mandatory; other 

properties are optional (Figure 9). 

 

Click the Finish button to proceed. 

 

 

 

 

  

 Figure 9 – Import sample wizard 
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Import target lists 

The procedure for the import of a target list is analogous to the procedure explained for the samples. The 

format of these import files, as well as example files can be found at 

http://www.biogazelle.com/support/qbaseplus/formats. 

 

Step 1 -  Start Import target wizard 

Right-click in the project explorer on Targets (or a random sample) to start the Import target wizard.  The import 

button ( ) in the toolbar will also lead to this wizard when selecting Targets. 

 

Step 2 -  Select target list 

Select the experiment in which the target list needs to be imported.  By default, the experiment selected in the 

project explorer is indicated as the target experiment. 

Browse for your target list file and click the Finish button. 

 

Edit samples and targets 

Samples and targets can be edited in multiple ways: they can be deleted, renamed or replaced, or their 

properties and annotations can be altered. 

 

Samples and targets can be deleted through the right-click context menu (cursor needs to be on the sample 

or target that should be deleted) or by selecting and clicking the Delete icon  in the command bar. 

Multiple samples or targets can be simultaneously deleted by selecting all of them. 

 

As of version 2.0, there is an option to clean up sample and target lists (available through the context menu), 

resulting in automatic removal of all unused samples or targets (ie not appointed to any well). 
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Existing sample or target names can be modified (rename) by double clicking their name in the Project 

explorer. A window opens where you can change the name (and other properties). Alternatively, a name can 

be modified using the menu bar (Edit > Rename), through the righ-click context menu or by using the F2 

keyboard button (Figure 10).  

 

It is not possible to rename a sample or target to a name that is already in use. E.g. if a given sample (or 

target) exists with two different names (e.g. due to typing error), the Replace option in the sample (target) 

right-click context menu should be used to replace the incorrect sample (target) name with the correct one 

(to be selected from a drop down list containing existing names). 

 

Sample/target settings and annotations are available by opening a Sample or Target window. Open such a 

window by double clicking the Sample or Target to be edited, or by using the Open option in the right-

click context menu.  

 

The Target window contains two tabs (at the bottom). When creating new targets, the Properties tab opens by 

default. Later, when reopening a Target for which results have already been calculated, the Results tab will be 

shown by default. 

 

The Sample window also contains two tabs (at the bottom) as of version 2.0. When creating new samples, the 

Type tab opens by default. The Properties tab contains an overview of all custom properties for that particular 

sample. 

An overview of all Custom sample properties of all samples is available in the Sample properties window 

(Figure 5). 

 

  

 Figure 10 – Rename or replace 
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Well annotation 

Following sample and target creation in the Project explorer, they have to be appointed to individual wells in 

a run. This part describes how to annotate single or multiple wells. See below for a description on how to copy 

the layout (position of samples or targets) of an entire run to another run. 

 

Step 1 -  Open run 

Open the run by double-clicking its name in the Project explorer, or use the Open option in the run right-click 

context menu. The Run window contains a Properties tab at the bottom in which you can change the run 

name or alter the date on which the run was generated. It also contains information regarding the format of 

the run. Samples and targets can be appointed to wells in the Matrix tab that depicts the run layout with an 

annotation bar on top (Figure 11). 

 

 

Step 2 -  Appoint sample and target names 

Select one or multiple wells in the run layout for which you want to add a sample, and use the Sample drop 

down list in the upper part of the window to search for the corresponding sample name. Multiple wells can be 

selected by dragging, by using the 'Shift' or 'Ctrl' keyboard buttons, or by selecting an entire row or column by 

clicking on the row or column header, respectively. As soon as a sample is appointed to a well, its name and 

type appear in the well (unknown, positive control, standard, or 3 types of negative control). Note that the 

sample type can be modified in the run annotation bar on top of the run layout itself (the same can be done 

through the Project explorer as mentioned before).  

 

In a similar way, one or multiple wells can be assigned to a certain target. To this end, the Target drop down list 

is used. 

 

 

  

 Figure 11 – Run layout 
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Step 3 -  Quantities 

For 'standards', an input quantity must be defined in the corresponding field in the run annotation bar.  In 

contrast to sample and target information, quantities are not selected from a drop down list but entered as a 

numerical value. Note that quantity values cannot be added to sample types other than Standard. 

 

In the past, this was the only way to assign quantities for standard samples. As of version 2.0, this value can also 

be inputted as a sample property in the Sample window as described above (Figure 3). 

 

 

Step 4 -  Exclusion 

In the run layout window, you can select the wells that need to be excluded from the analysis. This option does 

not erase the Cq value nor the sample/target annotation, which means that the excluded well can later be 

re-included in the analysis if needed. 

 

Note that empty wells and wells without Cq value are automatically excluded by qbasePLUS and cannot be 

included by the user. 

 

 

Step 5 -  Clear 

The options Clear Sample and Clear Target can be used to remove sample and target names from selected 

wells. It does not remove any other well information. 

 

The option clear wells completely erases the well specific information (including the Cq value), which means 

that it will be impossible to recover it later in the experiment. This option should be used cautiously, e.g. to 

remove a part of the run that is not relevant for the experiment. 
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Apply run layouts 

To speed up run annotation, qbasePLUS enables copying the layout of samples, targets or both from one run to 

another. When for instance the same set of samples is measured in different runs using the same layout (this is, 

the samples are measured in the same position in all runs), sample annotation of a run only needs to be 

performed once, saving you valuable time. This functionality can also be used across different (open) 

experiments. 

 

 

 

Step 1 -  Start Apply run layout wizard 

Right-click in project explorer on the run (or selection of multiple runs) for which you want to edit the run 

information (sample name and type, target name, quantities of standard wells) and select the Apply run 

layout option. 

 

Step 2 -  Select template run 

Select the run that serves as a template. Note that only runs can be selected from open (loaded) experiments. 

If needed, cancel the current procedure and right-click on closed (unloaded) experiment and select Load 

Experiment. 

 

Step 3 -  Apply run layout options 

Select properties that need to be copied (Figure 12). If annotation information is already present in the 

destination run, a warning will be displayed to notify you that information will be overwritten.  

 

 

 

 

 

 Figure 12 – Apply run layout options 
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